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Release Notes 
Dear Customer, 

Thank you for purchasing iC IR 7.2, the simply powerful software package for ReactIR™. 
Everything you need to install and run iC IR 7.2 is stored on the installation media (downloaded 
zip file). 

Contents of the Installation Media 

- iC IR 7.2 software installer (setup.exe) 

- iC IR 7.2 Release Notes (this file) 

- iC IR 7.2 Installation Guide for Administrators 

Installation Guide and System Requirements 

Please install iC IR 7.2 according to the installation. This also describes the minimum PC 
requirements to install and run iC IR 7.2. 

User Assistance 

The iC IR 7.2 Help file is available from the software and includes a link to the Help Portal for iC IR 
User Assistance, video tutorials and other useful links. 

Customer Support 

If you encounter any issues with iC IR 7.2, please don’t hesitate to contact your sales 
representative or service engineer, or contact us at: 

support.msg@mt.com for General Support on your ReactIR Instrument 

mailto:support.msg@mt.com
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Feature Comparison Table 
Key features of iC IR 7.2 compared with earlier versions and ReactIR 3.x: 

Feature iC IR 
v4.1 

iC IR 
v4.2 

iC IR 
v4.3 

iC IR 
v7.0 

iC IR 
v7.1 

iC IR 
v7.2 

Easy Data Collection and Instrument Collection 
Supports ReactIR 700 Instruments X X X X   

Supports ReactIR 45m Instruments      X 
Supports ReactIR 15 Instruments X     X 
Supports ReactIR iC 10 Instruments      X X 
Supports FlowIR instrument for continuous flow 
applications X  X    X 

Supports ReactIR 45P production instruments X  X  X X X 
Supports ReactIR 4000 Instruments   X X  X X 
Templates allow reuse of all settings from previous 
similar experiments  + + + + + 

Live experiment toolbar consolidates key status 
and control functions       

Offline data from HPLC or other methods can be 
easily captured and used to fit IR trends to 
quantitative concentrations 

   + + + 

Fit IR peak trends extended to work with any 
external trend values, including iC LC  X  X  X  X  X  

Rapid scan mode allows fast reactions to be 
sampled up to 1 Hz     X  X  X 

RTD inputs for trending reaction temperature 
(ReactIR 45m, ReactIR 15 and ReactIR 700)       

Auto align detector (ReactIR 45m) ensures optimal 
instrument performance       

Optional Instrument Performance Assurance (IPA) 
module allows polystyrene calibration and 
validation to ensure optimal data quality 

  + + + + 

Supports the DS Micro Flow Cell sampling 
technology X       

Supports Stirling engine MCT detector which 
eliminates need for liquid nitrogen X  X    X 
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Feature iC IR 
v4.1 

iC IR 
v4.2 

iC IR 
v4.3 

iC IR 
v7.0 

iC IR 
v7.1 

iC IR 
v7.2 

Streamlined experiment workflow with automatic 
system checks and improved clean probe function X  X  X    

Improved Water vapor correction available for all 
supported instruments X  X  X    

Intuitive Data Analysis and Visualization Intuitive D     

Linked views simplify analysis and highlight data 
relationships    + + + 

ConcIRT™ Live! – Automatic reaction information 
generation       

On-the-fly data treatments       

Event linked annotations and sample markers    + + + 
User defined trends – tailored information       

Annotation improvements – easy to add, move edit 
and display in different ways     + + 

Background replacement for all spectra and 
background extraction       

iC Quant univariate and multivariate modeling tool 
option       

Appending, merging, and trimming experiments       

Import Trends from other iC and iControl™ 
Experiment Files    + + + 

Sharing of notes and offline samples with other iC 
7.x and iControl 5.5 and newer applications X  X  X     

Support for ConcIRT Pro™ module to analyze data 
from multiple experiment or multiple techniques     X  X  X 

Data Treatments applied to reference spectra in 
experiments       

Add Peak Labels feature allows peaks to be 
annotated quickly and accurately X  + + + + 

Goodness of Fit and Auto-name components 
based on reference spectra option available for 
ConcIRT models 

X X     

iC Next Generation interface including ribbon style 
controls and separate windows for each document X  X X    

Find Trends one-click reaction profiling X  X X    
Smart Pin allows quick pinning based on time 
interval or events X  X X    
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Feature iC IR 
v4.1 

iC IR 
v4.2 

iC IR 
v4.3 

iC IR 
v7.0 

iC IR 
v7.1 

iC IR 
v7.2 

Zoom to Peak option for focusing Spectra and 
Surface viewers  X  X X    

Time regions allows analysis of specific parts of 
the reaction independently X  X X    

Easily copy peak trends to Scale-up Systems 
applications like Dynochem and Reaction Lab X  X X X X  

Quick Reporting and Data Exchange 
Auto export of spectra or trend data to standard 
formatted files during experiment    + + + 

Single click simple report generation     + + + 

Easy and flexible WYSIWYG Report Designer 
including export to Microsoft® Word® X X X    

New data tab shows trend values for all selected 
spectra       

Integration with iC Data Share™ Excel Add-in and 
iC OPC UA Server for real-time sharing of trends 
with Microsoft Excel and other 3rd party apps 

X X     

Support for iC Data Center™ to automatically 
capture, prepare and share experiments X X     

Compatibility 

GAMP and 21 CFR Part 11 compatible       

Microsoft® Windows® XP compatible    X X X 

Microsoft® Windows® 7 32-bit compatible X   X X X 

iC IR Office compatible with 64-bit versions of 
Microsoft® Windows 7®    X     X 

iC IR Instrument compatible with 64-bit versions of 
Microsoft® Windows® 7  X X    X 

Microsoft® Windows® 8.1 compatibility X X X   X 

Microsoft® Windows® 10 compatibility X X X    

Microsoft® Windows® 11 compatibility X X X X  X  

 = Supported feature  + = Supported feature with enhancements  X = Not supported  
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These release notes summarize incremental changes in iC IR. 

Enhancements for Version 7.2 

Full Support for Microsoft® Windows® 11 Operating System 

iC IR 7.2 fully supports the Microsoft® Windows® 11 operating system for both Instrument control 
and Office versions in addition to Microsoft® Windows® 10 support (minimum Windows 10 1903 
April 2018 Update). 

Experiment Samples Limit Increased to 20,000 

Per customer request, the maximum number of samples that can be collected during one 
experiment has been increased from 6,000 to 20,000. This allows up to 2 weeks of data 
collection when using a 1-minute interval. Note that to maintain optimal performance, it is strongly 
recommended to only have one such experiment running at a given time if multiple instruments are 
connected to one computer. The previous limit of 6,000 is still the recommended limit when 
running multiple experiments at the same time. 

‘Fit Analytic Data’ Can Be Applied to Any External Trend 

In previous versions, this feature was called ‘Fit Offline Analytical Data’ and the user was limited to 
select a column defined in the Offline Samples table.  

In iC IR 7.2, this feature has been expanded to allow any external trend to be selected, provided 
that the external trend’s data overlaps in time with the trend being fitted. Hence this feature has 
been renamed to ‘Fit Analytic Data’ and can now be more widely applied. 

Copy Trends for Scale-up Systems Dynochem or Reaction Lab 

A button is now available on the Home ribbon that copies all peak trend values to the Windows 
clipboard in a format that can be directly pasted in the Scale-up Systems modelling applications. 
This allows for trend data to be easily imported into Reaction Lab and Dynochem, as well as scale-
up utilities and web apps.  

New Hardware Setup Videos Included in Help 

Three new videos that highlight how to setup and run experiments with the ReactIR instrument have 
been added to the Help page in iC IR 7.2. These videos combine footage of the physical ReactIR 
instrument with screen captures of the iC IR software. There is a specific video for setting up the 
ReactIR 702 and one for the 701 instrument as well as a general ‘How to run an experiment with 
ReactIR’ tutorial to help new users become familiar with the hardware and software as quickly as 
possible.  
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Ability to Save Instrument Reports as PDF 

The instrument Stability, Performance, and Calibration Reports now have an option to Save as PDF. 
This new menu selection is available from the report viewer within iC IR. Note that the reports are 
still automatically saved as Microsoft XPS files but the user now has the ability to manually 
generate a PDF as well, if desired. 

File Format Update for .iCQuant Files 

In order to remove an unneeded dependency that could cause incompatibilities on some systems, 
the file format for iC Quant files has changed in iC IR 7.2. There are a few consequences of this 
change that it is important for users to be aware of: 

1. An attempt to open or load an older version of an .iCQuant file will require the file to be 
converted to the new format. Users will be notified before the conversion takes place and 
will have the option to cancel the action. This conversion will not overwrite the original file, 
instead the original file will be renamed with the suffix “_back”.   

2. Any .iCQuant file saved in iC IR 7.2 cannot be opened in older versions of iC IR. 

 

 

Discontinued Features for Version 7.2  

The following features were included in earlier versions of iC IR but are no longer supported in the 
latest generation iC IR 7.2. 

Discontinued Support for Legacy ReactIR Instruments 

ReactIR 15, ReactIR 45m and FlowIR instruments are no longer selectable on the Configure 
Instrument page as these instrument models have been discontinued for some time. However, iC IR 
experiments that were run in iC IR 7.1 with these instruments can be opened, analyzed, and 
reported in iC IR 7.2.  

Customers that are still actively using ReactIR 15, ReactIR 45m or FlowIR systems should not 
upgrade to this new version. 

Gain Setting for ReactIR 700 Instruments Has Been Removed 

Previously, the Instrument Configuration page allowed the user to set the instrument Gain to 
Medium, High, or Extreme for a ReactIR 700 instrument. This option has caused some confusion 
and issues, so the option has been removed. The optimal level for Gain on the ReactIR 700 is Low 
so this is now set and no longer modifiable.  
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Known Issues 

No. Issue Description and Workaround 

1. 

FB34831 

Communication Issues with 
USB Network Interface 
Controllers 

Some communications issues 
have been observed when using 
USB network interface controllers 
(NICs). 

There are no known workarounds other 
than to avoid connecting the instrument 
to USB network interface controllers, if 
possible.  

2 

33541, 51919 

Remote Connection Issues 

Software may become 
unresponsive when connecting 
remotely to the computer. 
Experiments can hang on 
completion or crash when 
working with the experiment. 

Avoid remote connections, like using 
Remote Desktop, to a computer running 
iC IR, especially during a running 
experiment. 

If a remote connection is required, then 
do not have the Surface Viewer displayed 
as this contributes to the issue. 

3. 

87448 

3D Surface Viewer Graphics 
Issue 

The 3D Surface Viewer is not 
visible or barely visible. 

Update graphics drivers. If the computer 
is using Intel onboard graphics, updating 
the driver to version 31.0.101.3959 or 
later will fix this issue. 

It is unclear whether this issue could be 
observed with a dedicated graphics card. 
If it is, then update the driver for the 
graphics card. 

4. 

27640 

Offline Samples May Be 
Omitted by Merge Operation 

If offline analytical samples have 
been added to both experiments 
with default sample IDs, the 
duplicate IDs can cause samples 
to be omitted by the Merge 
operation. 

This can be avoided be making sure 
there are no duplicate Sample IDs before 
merging experiments. 

Since the merging process leaves the 
original experiments unchanged, any 
omitted samples will still exist in the 
original file, and can transcribed 
manually. 
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No. Issue Description and Workaround 

5. 

32164 

Offline Analytics Table Pasting 
Issue 

Pasting invalid values into the 
Offline Data table can cause 
subsequent, successful pasting 
actions to appear to fail. 

 

Pasting invalid values into the offline data 
table can cause the table to not update 
when subsequent, successful paste 
actions are performed. 

Closing and reopening the window will 
put the table back into a normal, working 
state. 

6. 

33401 

Cancelling a Merge Operation 
Is Unreliable 

In certain cases, pressing the 
'Cancel' button during an 
experiment merge does not stop 
the merging process. 

Merging experiments is a non-destructive 
process that creates a new file and leaves 
the original experiments unchanged.  

We recommend not trying to cancel the 
merge operation. Instead, let it go to 
completion and just delete the merged 
experiment file if it is no longer needed. 

7. 

31045 

The Spectrum Shown in 
Baseline Offset and Normalize 
Windows May Have Math 
Function Applied  

These dialogs show a fully 
treated spectrum, which is 
misleading because the baseline 
/ normalization is not applied to 
a fully treated spectrum. 

If the user applies spectra treatments in a 
non-traditional order, these windows 
could be showing derivatized spectra, 
which could lead the user to select invalid 
baseline / normalization points. 

When applying spectra treatments, it is 
best practice to apply them in the order 
that they appear in the menu ribbon. 

8. 

FB3109533 

ConcIRT Component Names 
Can Change During Experiment 

During a live experiment, the 
number of components identified 
by ConcIRT and their component 
names might change due to a 
change in significance.  

 

This issue was also present in previous 
versions of iC IR and is only seen if the 
'Show ConcIRT Trends' option is selected. 
This 'component swapping' behavior will 
not be present if users wait to turn on the 
'ConcIRT' option after the experiment is 
complete. This issue is important if live 
ConcIRT trends are used by iControl 
software to control reactors. 
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No. Issue Description and Workaround 

9. 

FB35688 

iC Quant Models Allow Spectra 
with Incompatible Resolutions 

The software should prevent the 
addition of a spectrum that is 
incompatible with spectra already 
in the model. 

There is currently no workaround. Users 
should take care to prevent this from 
occurring. 

10. 

52840 

Drift in sample interval when 
running with ReactIR 700 

When running long experiments 
there is the possibility that the 
time taken to collect samples can 
start to take longer as more 
samples are collected 

This is more of an issue when running 
multiple instruments from the same 
computer. 

If an increase in sample interval is a 
concern, it is recommended that iC IR be 
restarted after any long experiments since 
the increased overhead can be carried on 
to future experiments. 

11. 

52758 

Experiment can end 
immediately after duration 
change 

When modifying the current 
interval, if the duration is set to a 
time that is less than the interval 
then the dialog will close and the 
experiment will end.  

Be careful when editing the current phase 
during a live experiment. Make sure the 
duration is not set to a value lower than 
the interval. 
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Enhancements for Version 7.1 

Support for ReactIR 700 Instruments 

iC IR 7.1 supports the new ReactIR 700 family of instruments. These new small and flexible 
instruments:  

• Are auto-detected by the iC IR 7.1 software when connected to the computer 

• Use existing sampling technologies 

• Eliminate the need for liquid nitrogen when using TE-MCT detector in ReactIR 702L 

• Support connection and use of up to two ReactIR 700 systems on one computer 

• Collect with faster sampling intervals, as quickly as every 5 seconds 

For more details on this exciting line of instruments, please contact your local Mettler Toledo 
representative or go to www.mt.com/ReactIR  

Ability to Show Notes as Labels in Trend Chart 

By default, user-added notes are now shown as labels on the Trends Viewer. These text labels can 
be moved using the mouse or edited in place by double-clicking.  If desired, the labels can be 
hidden using an option on the View ribbon. 

Start Experiments from OPC UA (with collect background option)  

iC IR 7.1 now supports starting an experiment remotely with the iC OPC UA Server. The user can 
choose to collect a new background as part of starting an experiment.  

Used in combination with the iC OPC UA Server, users can control the data acquisition (start, 
pause, stop, edit sample interval and duration, etc) and send both trend and spectra data to an 
OPC UA Client application, like a DCS. The iC OPC UA Server is available on your iC IR installation 
disc or downloaded from the AutoChem Customer Community website 
(https://community.autochem.mt.com/icopc). 

Note that use of the iC OPC UA Server is only recommended for users who are already familiar with 
the sophisticated OPC UA standard. For simpler real-time data sharing, the iC Data Share Excel 
Add-in can be used, also available on the iC IR disc and the AutoChem Customer Community 
website. 

Improvements to Create From Difference 

iC IR 7.1 has added the ability to zoom and pan in the 'Create From Difference' workspace. This 
gives the user greater flexibility when looking at spectra in the workspace. Additionally, the selected 
value bar now displays the current wavenumber position. 

 

http://www.mt.com/ReactIR
https://community.autochem.mt.com/icopc
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Discontinued Features for Version 7.1  

The following features were included in earlier versions of iC IR but are no longer supported in the 
latest generation iC IR 7.1: 

• Adding a ReactIR iC 10 instrument. Users can still open and analyze files with data 
collected from a ReactIR iC 10 instrument. 

 
 

Enhancements for Version 7.0  

Full Support for Microsoft® Windows® 8.1 and 10 (64-bit) Operating Systems 

iC IR 7.0 fully supports the Microsoft® Windows® 8.1 and Microsoft® Windows® 10 64-bit 
operating systems for both Instrument control and Office versions in addition to Microsoft® 
Windows® 7 support. 

Updated User Interface Makes Functionality More Discoverable 

The new generation of iC products use a more modern interface based on the latest Microsoft® 
Windows® platforms. The new start page, updated file menu structure and overall layout all follow 
those used by the latest Microsoft® Office products. Important user interface changes include 

• User functions are located in menu ribbons and in local viewer controls, and are no longer 
hidden in right-click menus. 

• Each document now has its own window, making it easier to view multiple experiments 
side by side. 

• Any viewer (i.e. Spectra, Trends, Data) in the layout can quickly be expanded to full size 
by clicking the expand icon in the upper right corner of the pane. The view can be reset 
back to the multi-panel view by clicking the same button again. Additionally, there are 
more layout options available to better customize the user experience. 

• Some ribbon items (Manage Peaks, User Defined Trends, and Quantitative Trends) require 
more screen space than the ribbon affords, so these buttons will populate a workspace 
panel that appears across the bottom of the window. This allows seeing the results of 
updates in the main viewers while the options in the workspace are changed.  

Find Trends – One Click Reaction Profiling 

The Find Trends feature assists users in identifying real peak trends that reflect actual reaction 
components, and does so more quickly than was possible in previous versions of iC IR. Find 
Trends leverages the powerful ConcIRT algorithm   to analyze the experiment for changes over time 
and create a statistical model. For each of the model’s components, Find Trends identifies isolated 
peaks whose trends most closely match the model-generated trends, and lists functional groups 
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that are known to absorb in or near the peak’s wavenumber region. The user can then select an 
appropriate real peak to follow for each component based on their reaction chemistry and add 
them to the experiment.  

Find Trends can be configured to analyze specific wavenumber regions and to work within a user-
defined time region. Adjusting these configuration settings to better reflect reaction conditions can 
improve the ConcIRT model and translate to higher quality peak trends. Watch the Find Trends 
tutorial video included with the software to see a demonstration of this exciting new tool. 

Smart Pin 

The Smart Pin feature allows the user to quickly pin samples across the entire experiment or over a 
specific time region. The samples can be spaced evenly over the range or based on experiment 
events like user notes and offline analytical samples. Smart Pin removes the existing pins in the 
region before adding the new pins based on the selected criteria. 

The Smart Pin dialog also includes an option to unpin all samples in the experiment. 

Customizable Report Generation 

iC IR features an easy to use WYSIWYG (what you see is what you get) Report Designer allowing 
users to create experiment reports that fit their company’s standards. A ‘Report’ page is included as 
part of every iC IR experiment which by default includes all the significant data from the experiment. 
The user can easily customize this report from within iC IR by simply dragging & dropping items 
such as Trend Graphs, Spectra or the Experiment Event Logs. Users can also add experiment 
specific text or images from other sources to the report before, during, or after the experiment 
completes. The resulting report can then be exported to Microsoft® Word® so it can be easily shared 
with others. Watch the 'Create Reports' tutorial video included with the software for a demonstration 
of the report designer. 

Improved Water Vapor Correction  

A new workflow has been developed to collect a water vapor spectrum that can be used to 
eliminate water vapor effects in your experiments. Because water vapor concentration increases 
with temperature, a water vapor spectrum can be determined by the collection two ‘air’ spectra at 
different temperatures. The new water vapor collection workflow takes one sample immediately after 
the instrument is turned on, when the instrument is cool, and another after the instrument is fully 
warmed up and then calculates the water vapor spectrum based on the difference. 

This new workflow results is a higher quality water vapor spectrum and, consequently, cleaner 
spectra in your experiments. 

Improved Workflow for Cleaning the Probe/Sensor  

The Clean Probe workflow, where the system compares the live scan against the saved instrument 
background, is much more intuitive in iC IR 7.0. In order to encourage good laboratory practices, 
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iC IR 7.0 automatically starts the Clean Probe workflow when an experiment completes. It is 
recommended that the probe be cleaned at this time, but it is not required. If the Clean Probe 
workflow is aborted, the system will remember this and recommend that the probe be cleaned prior 
to starting the next experiment. 

The Clean Probe window shows a live indication of whether the clean criteria are met. When the 
probe is deemed clean, the user can optionally collect a new background. If the probe cannot be 
cleaned to the extent that the ‘clean’ criteria are met, the user will be notified that the test did not 
pass, but can still optionally collect a new background. 

Streamlined Workflow for Experiment Setup  

The experiment setup wizard from iC IR 4.3 has been replaced with a more streamlined workflow 
that includes only the essential setup steps.  There are now three workflows for creating a new 
experiment: Quick Start, Clone Experiment and From Template. 

• Quick Start allows the user to start a new experiment from scratch in just a few clicks. 
• Clone Experiment allows the user to quickly create a new experiment with the same data 

analysis settings as a previously run experiment. 
• From Template allows the user to create a new experiment based on a user-created 

template 

System readiness checks, such as instrument alignment are performed behind the scenes and the 
user will be notified only if there is an issue to be addressed. 

Prior to starting the experiment, the user is not forced into the Collect background workflow as long 
as the last saved background is less than 48 hours old. Collecting a new background before each 
experiment is still considered a ‘best practice’, but iC IR 7.0 leaves that decision to the user. 

The collection of reference spectra is no longer included as part of the experiment setup process, 
since it is typically done well before the user is ready to start the experiment. Collecting reference 
spectra is now supported only in a spectra set (previously called ‘spectra library’). From the 
spectra set, the spectra can easily be imported into an experiment. 

Increased Maximum Experiment Size to 6000 samples 

Previous versions of iC IR limited experiments to collect a maximum of 2880 samples. This limit 
has been increased to 6000 samples in iC IR 7.0. For longer experiments, the samples can be 
collected in multiple experiments and merged once the experiments are complete.  

Streamlined Zooming and Panning in Charts, Including Touch Screen Support 

The ability to zoom and pan in the Trend, Spectra and Surface charts is much more user-friendly in 
iC IR 7.0. The user can quickly zoom in or out using the mouse wheel and pan in any direction 
simply by clicking and dragging.  Also, zooming and panning is possible using hand gestures on 
touch-based systems. The iC IR 4.3 method of zooming to a rectangular area, is still supported in 
iC IR 7.0 as well. 
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iC IR 7.0 also allows the user to undo a single zoom or pan operation without having to zoom all 
the way out and start from scratch. 

Enhancements to 3D Surface Viewer 

The user can double click a point (Time and Wavenumber) on the surface to add a peak. This 
works by picking the spectrum associated with the point’s Time and picking the peak at the 
selected wavenumber, similar to the analogous function in the Spectra chart. 

The surface chart also shows the selected and non-selected peaks in the Surface chart, similar to 
the Spectra chart behavior. 
 
There are also a number of additional display options available for the Surface viewer from the 
'View' ribbon including: 

• There are options to snap to specific view angles available.  
• The color theme selection has been simplified. Now there are two options: ‘Color’ and 

‘Black and White’. 
• The opacity of the surface is adjustable with a slider. 
• For the Black and White color theme, the shading is adjustable with a slider. 

Improved Auto-scaling for Spectra   

The spectra viewer allows the user to specify how the spectra shall be re-scaled as the chart is 
zoomed and/or panned. The options are: 

• Rescale Y (default): In this mode, the Y axis will be rescaled based on the spectra data in 
the displayed wavenumber range. This automatic rescaling allows the user to pan to an 
area of relatively low absorbance and see significant spectrum features without manually 
zooming. 

• Unscaled Y: In this mode, the Y axis is not auto-scaled, and can be zoomed manually by 
the user. This mode offers maximum flexibility, but requires more interaction from the user. 

• Normalize Y: In this mode, all spectra visible in the chart are rescaled to a range of 0-
100% in the displayed wavenumber range. Like with Rescale Y mode, the chart auto-
scales the spectra as the user zooms/pans; however, Normalize Y mode will rescale each 
spectrum independently of the others. 

Trend Axis Assignment and Scaling Improvements  

When a trend is added, or a trend’s units are changed, iC IR 7.0 will automatically assign the trend 
to the same Y axis as other trends with the same units. This is intended to save the user from 
having to assign trends manually. The user can override the auto-assigned axis if desired by 
selecting among six available Y axes using the Trend legend control.  
 
The 'Normalize Peak Trends' feature available on the 'Home' ribbon rescales all peak trends to a 
range of 0-100%. This can be helpful in analyzing reaction kinetics. 
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Illumination of Functional Group Bands in the Spectra Viewer  

iC IR allows the user to select a functional group from a list and the spectra viewer will display the 
approximate position of the functional group’s known absorbance bands. This is available from the 
'View' ribbon under 'Show Functional Group'.  

More Options for Exporting Spectra (CSV, SPA) 

In addition to SPC files, it is now possible to export spectra to SPA (Nicolet) and CSV (comma-
separated value) files. These options are set from the 'File' -> 'Options' -> 'User Preferences' page 
and can be enabled or disabled for individual experiments from the 'Live' ribbon while an 
experiment is running. 

Improved Usability of Offline Analytic Data Related Functions 

The ability to add offline analytical samples (formerly called “referee samples”) and use the results 
to rescale a peak trend is more prominently featured than it was in iC IR 4.3. The workflow to add 
offline sample results, like from HPLC, is also far simpler and supports pasting of data values.  

Sharing of Notes and Offline Sample Data across Linked iC and iControl Experiments 

When a live iC IR experiment is linked to another live iC 7.x or iControl 5.5 (or newer) experiment 
running on the same computer or a remote computer, user notes and offline sample data will be 
shared across the linked experiments. Two experiments are ‘linked’ when a trend is copied from 
one live experiment to another live experiment. 

The sharing of offline sample data with iControl allows iC IR users to benefit from automated 
sampling using an EasySamplerTM, as the taking of the sample is triggered and recorded in iControl 
and shared with iC IR.   

Data Trimming/Thinning More Flexible than Before 

In addition to the existing iC IR 4.3 feature that allows the user to delete a contiguous series of 
samples, iC IR 7.0 allows support the ‘thinning’ of samples. The user can specify the frequency of 
samples to be retained either over the entire experiment or within a user-defined time region. 
Please note that iC IR 7.0 does NOT allow the reduction of samples by deletion or thinning to be 
undone  once the experiment is saved. 

More Intuitive Behavior for Reference Spectra with Data Treatments Applied 

In iC IR 7.0, a spectrum will retain its existing data treatments when it is copied into an experiment 
or a spectra set as a reference spectrum. The one exception to this rule is that an experiment’s 
Math Function setting will be applied to all reference spectra in the experiment, overriding the 
spectrum’s original Math Function setting. 
 
This differs from the behavior in iC IR 4.3 where all of the reference spectrum’s data treatments 
would be overridden by the experiment’s data treatment settings. 
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Peak Editing: Zoom to Peak, Possible Functional Groups 

In the Manage Peaks workspace, there are two new features that act upon the selected peak: Zoom 
to Peak and a list of Possible Functional Groups 

• Zoom to Peak: This button allows the user to zoom spectra viewer and 3D surface viewer 
to the wavenumber range in the peak definition for the selected peak. 
Possible Functional Groups: A dynamically updated list of functional groups is shown for 
the selected peak. This list shows functional groups that are known absorb in the selected 
peak’s wavenumber region and updates as the peak’s wavenumber region is modified. 

 

 

 

 

Delayed Features for Future Version 

There are some features that are planned for the next generation iC IR platform that have not been 
implemented yet in 7.0.  

Rapid Collect Experiments 

iC IR 7.0 does not support experiments to be run in ‘Rapid Collect’ mode. iC IR 7.0 does allow 
Rapid Collect experiment files to be loaded with the last known co-addition setting, but does not 
allow the co-addition setting to be changed. Users wishing to change the co-addition for a Rapid 
Collect experiment should use iC IR 4.3 to do so. 

Support for ReactIR 45P 

Currently, iC IR 7.0 does not support control of ReactIR 45P instruments and does not interface to 
iC Process, but support for this production instrument is planned for the next major version release. 
 
In the meantime, there is a way to create an iC Process templates from iC IR 7.0 experiments. 
Since iC IR 7.0 experiment/template files cannot be opened in iC IR 4.3, the workflow for repeating 
an iC IR 7.0 experiment on an ReactIR 45P instrument and then creating a template for iC Process 
contains a few extra steps. The workflow is as follows: 

• In the open iC IR 7.0 experiment, go to 'File' -> 'Export' -> 'Settings Summary'. Select a 
folder and ‘Export’. This creates a report containing data analysis settings from the 
experiment and also exports any reference spectra and trends to data files. 

• In iC IR 4.3, create a new experiment for the ReactIR 45P. 
• Manually apply the data settings recorded in the report and import the reference spectra 

and trends from the data files. 
• Save the iC IR 4.3 experiment as a Template. 
• Load the template into iC Process as a method. 
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ConcIRT Pro Module 

iC IR 7.0 does not currently support the full ConcIRT Pro module which allows users to run the 
ConcIRT algorithm on multiple experiments or for multiple technologies at one time. Two of the 
most used features of ConcIRT Pro have been integrated into the Find Trends options in 7.0 though. 
The ability to specify the number of components for the ConcIRT model and to force the algorithm 
to use specific reference spectra as inputs are available on the 'Options' tab of Find Trends. 
 

 

Discontinued Features for Version 7.0  

The following features were included in earlier versions of iC IR but are no longer supported in the 
latest generation iC IR 7.0: 

• Selecting C1 Fiber as a Probe Interface 

• Large Value Display 

• Replay mode for experiments 

• ‘Sample Number’ time format for y-axis 

• Several user defined trend (UDT) types have either been converted to a new form or 
eliminated entirely. UDTs Converted to a new form: 

o Smooth (Exponential): Exponential smoothing can be applied to any trend via the 
trend viewer extended legend. 

o Scale: The linear scaling of a trend using a scaling factor and offset is now 
accessible in the ‘Trend Scaling’ section of the Analyze ribbon. 

o Fit Referee Data: This is also accessible in the ‘Trend Scaling’ section of the 
Analyze ribbon. However, the ability to show the scaled trend as %Conversion is 
no longer supported. 

• UDTs that have been eliminated: 

o Smooth (Savitsky-Golay): It was decided that only one type of smoothing 
(exponential) was needed. 

o All ‘%Conv’ and ‘%Yield’ types: These were ultimately determined be redundant 
with the ‘factor and offset’ scaling feature described above. 
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Enhancements for Version 4.3  

Full Support for Windows 7 64-bit Operating System 

Previously, iC IR did not support control of an instrument with a 64-bit operating system. iC IR 4.3 
fully supports the Windows 7 64-bit operating system for both Instrument control and Office 
versions. 

Support for ReactIR 45P and ReactIR 45P Dual Instruments 

The ReactIR 45P is a new Process Analytical Technology (PAT) instrument designed for in situ 
monitoring of batch process chemistry. It supports the full range of sampling technologies and is 
available with either a DTGS or Stirling Engine MCT detector. The ReactIR 45P Dual is the dual-
probe variation of the ReactIR 45P. It has all of the functionality of the ReactIR 45P except that it is 
limited to using AgX fiber probe technology or the DS Micro Flow Cell. 

Support for FlowIR Instruments for Continuous Flow Applications 

FlowIR is a new instrument type designed specifically for continuous flow applications using the 
Flow Cell sampling technology. For this release, only one FlowIR unit can be run at a time from a 
single PC. In order to use multiple FlowIR instruments for multiple steps in a continuous flow 
process, you will need multiple PCs, each running iC IR 4.3. 

Support for Stirling Engine MCT Detector which Eliminates Need for Liquid Nitrogen 

For select instrument types, the ReactIR instrument can be configured to use a Stirling engine MCT 
detector, which can provide cooling without the need for liquid nitrogen. The Stirling engine is 
turned on automatically at the point where scanning is required and turned off automatically when 
the instrument has been inactive for a configurable period of time.  

The Stirling Engine MCT detector is supported for the following instrument types: 
•  ReactIR 15 
•  ReactIR 45P and ReactIR 45P Dual 
•  ReactIR 45m 
• Fiber MultiplexIR 
• MultiMaxIR 45m 

Show Goodness of Fit for ConcIRT Models 

For ConcIRT results, the software calculates the Goodness of Fit which describes how well the 
model explains the spectral data. For experiment documents, this value is displayed in the Data 
Treatments task pane in the toolbox. For ConcIRT Pro documents this value is shown in the 
ConcIRT task pane. 
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Supports Auto-Naming of ConcIRT Components 

When the “Auto-name components” checkbox in the Data Treatments task pane is checked, iC IR 
will attempt to match the ConcIRT-calculated components to reference spectra in the experiment. If 
successful, the calculated component will be renamed accordingly.  

Integration with iC Data Share Excel Add-in 

The iC Data Share software application is an add-in module for Microsoft Excel that allows real-
time sharing of data.  iC Data Share can pull data from a running iC or iControl experiment into 
Excel so that it can be used in calculations, and resulting values can then be sent back to iC IR 
and trended.  This provides an easy way to integrate live data from other third party applications 
that support Microsoft Excel interfaces. 

The installer for the iC Data Share add-in is provided in a separate folder in the iC IR 4.3 
Installation CD or downloaded zip file.  iC Data Share can be installed on the same computer as iC 
IR 4.3 or on a different computer as long as it has network access to the iC IR 4.3 system. 

Instrument Performance Assurance (IPA) Support for More Instruments 

Instrument Performance Assurance is a validation and calibration package available as an option 
for the select ReactIR instruments.  In iC IR 4.3, the supported instrument list has expanded from 
the ReactIR 45m and iC10 to include the ReactIR 15, ReactIR 45P and ReactIR247 instruments. 
For the ReactIR 45P instrument, the insertion of the polystyrene film is automated. For the ReactIR 
15 and ReactIR 247 instruments, this process is manual.  

See the “Enhancements for Version 4.1” section below for a more information on the IPA feature. 

Support for Exponential Smoothing Calculation for User-Defined Trends 

The ‘Smooth’ calculation now supports both Savitzky-Golay and exponential smoothing. In 
previous versions, only Savitzky-Golay smoothing was supported. Savitzsky-Golay smoothing 
requires a window size (number of points). Exponential smoothing requires an Alpha. 

Improved Spectrum Subtraction Using the Savitzky-Golay First Derivative Method 

By default, the calculation for spectrum subtraction will use the Savitzky-Golay First Derivative 
method. Previous versions use the Difference method. The Difference method is still supported, but 
only when enabled as a user preference under the Tools -> Preferences.  

Show Preview of Reference Spectrum before Starting Collection 

In the Collect Reference step of the New Experiment wizard or the Record Spectra Library wizard, 
the real-time spectra, based on a single scan, will be shown prior to starting sample collection. 

Increased Maximum Phase Duration to 30 Days  
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The user can specify phases of up to 30 days. The previous maximum was 7 days. However, the 
total number of samples allowed in an experiment remains 2880. 

Automatic Update of Peak Name when Peak Definition Is Changed 

For peaks that still have their default name (i.e. “Peak at XXXX cm-1), the name will be 
automatically updated when the peak is changed.  

Correction of iC Quant Calculations for Mahalanobis Distance and F-Test Diagnostics  

The calculations for Mahalanobis distance and F-Test diagnostics have been corrected. For any iC 
IR experiments that use previously loaded iC Quant models for prediction and diagnostics 
calculation, follow the steps below after software upgrade to get the updated Mahalanobis Distance 
and F-Test Values.  

a) Open the iC IR experiments that have iC Quant models loaded in the Quantitative Analysis 
toolbox 

b) Unload any previously loaded iC Quant models. 

c) Open these iC Quant models with iC IR 4.3. The model will be calibrated automatically 
once it is open. Save the model as a new name or overwrite the old file. 

d) Go to the Quantitative Analysis toolbox and load the desired iC Quant models again for 
prediction.  

e) Now the Mahalanobis Distance and F-Test diagnostics values shall be updated 
appropriately. The diagnostics values calculated in prediction mode shall now match the 
diagnostics values calculated in iC Quant build mode if the same spectrum sample is 
used.  

 
 

Discontinued Features for Version 4.3  

Discontinued Support for ReactIR 4000 Based Instruments 

The ReactIR 4000 and the MultiMaxIR™ 4000 instruments are no longer selectable in the 
Configure Instrument Wizard. The ReactIR 4000 hardware has been discontinued. Customers with 
ReactIR 4000 or MultiMaxIR 4000 instruments should not upgrade to iC IR 4.3. 

Discontinued iC RCT Support for MonARC Instruments 

The iC RCT task pane is no longer available with iC IR 4.3 so MonARC systems that use the PIA 
software for control are not supported.  Note that iC Process™ for MonARC will be supported with 
iC IR 4.3 but only certain, newer MonARC systems can be upgraded to use this interface.  
Customers with MonARC systems that use the PIA software should not upgrade to iC IR 4.3. 
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Limited Support for MultiMaxIR 45m Instruments 

Although MultiMaxIR 45m instruments are selectable configurations in the Configure Instrument 
Wizard, they have not been thoroughly tested. It is recommended that MultiMaxIR 45m users do 
NOT upgrade to iC IR 4.3 at this time. 
 
 

 
Enhancements for Version 4.2  

Full Support for 32-bit versions of Windows 7 and Vista Operating Systems 

iC IR 4.2 fully supports the 32- bit versions of Windows Vista and Windows 7 as well as Windows 
XP.  

NOTE: Although iC IR supports Windows Vista and Windows 7, the ReactIR 4000 instrument 
interface does not – so ReactIR 4000 users must remain on Windows XP. 

iC IR Office Support for 64-bit versions of Windows 7 and Vista Operating Systems 

iC IR 4.2 supports the 64-bit versions of Windows Vista and Windows 7 for iC IR Office 
installations. Any computer that will be connected to an instrument must use a 32-bit operating 
system due to current constraints with the device drivers.  

Supports the DS Micro Flow Cell for Continuous Flow Chemistry 

The DS Micro Flow Cell is a seamless, in situ measurement and monitoring solution for continuous 
flow chemistry processing. Continuous flow chemistry offers potential advantages for safety, 
scalability, and flexibility over batch chemistry.  Combining the highly molecular specific nature of 
Fourier Transform Infrared (FTIR) to continuous flow chemistry enables researchers, scientists, and 
engineers to quickly and easily develop continuous flow processes for their products that would 
otherwise be considered a traditional batch method.  

iC IR allows an instantaneous view of reaction progression, dispersion characteristics, and side-
reactions with or without prior knowledge of the chemistry under development/production. 

The DS Micro Flow Cell is compatible with ReactIR iC10, ReactIR 4000, ReactIR 45m, 
ReactIR 45 Dual Probe and the new ReactIR 15 instruments.   

Supports the ReactIR 15 instrument 

The ReactIR 15 is a sealed instrument that does not require purging.  Yet it retains most of the 
capabilities of the ReactIR 45m with the following exceptions: 

• Compatible only with AgX fibers and the DS Micro Flow Cell. 
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• Supports only single-probe applications. Hence, only one RTD is supported as well. 

• Does not support Instrument Performance (polystyrene) Validation and Calibration. 

• Auto-alignment of the detector mirror is not supported, however manual adjustment of the 
fixed mirror is available.  

Supports the ReactIR 247 instrument 

The ReactIR 247 instrument is an instrument designed to operate in a process environment. The 
instrument can be controlled directly by iC IR (just like any other ReactIR instrument) or indirectly 
via the Process Task Pane (similar to the way a MonARC can be controlled via the iC RCT task 
pane).  Unlike the MonARC, the ReactIR 247 also supports a web-based interface for operators. 

Process Task Pane for Interaction with the iC IR for Process Server 

This task pane allows the user to interact with data from the iC IR for Process server in the following 
ways: 

• View live Process data as a live iC IR experiment. 

• View historical data as an iC IR experiment by specifying a batch name or a range of dates 
and times. 

Also from the Process task pane, the user can import trends that span multiple iC experiment files 
into a new Result Set document. This requires no interaction with the iC IR for Process server. 

 

Improved Default Y Axis Captions for Trends 

iC IR 4.2 does smarter grouping of trends for the Y-axis.  This means that trends having similar 
units will, by default, be grouped on a single Y axis and that trends that have different units or are 
otherwise fundamentally different, such as Peak Height and Peak Area, will be on different Y axes. 
For example, a user defined trend with units of % will appear on the same axis as an iC Quant™ 
component trend with units of %. But an iC Quant™ component trend with units of g/L will be on a 
different Y axis. 

Improved AutoScale Behavior in Trend Viewer and Spectra Viewer   

When AutoScale is turned on in the Spectra Viewer or Trend Viewer, the Y axis now shows the 
actual values for the selected spectrum or trend. If no spectrum or trend is selected, the Y axis will 
be shown as 0% to 100%. 

New Rainbow Color Scheme to Surface Viewer  

The new ‘Rainbow’ color scheme option for the Surface Viewer assigns colors based on Y value, 
from low (blue) to high (red). 
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New Mode in Spectra Viewer Makes Annotating Peaks Easy and Accurate 

There is a new toolbar button in the Spectra Viewer that, when clicked, allows the user to add peak 
labels simply by dragging a line across multiple peaks in the selected spectrum. For any peak that 
is intersected by the dragged line, iC IR will calculate the peak center location and add an 
annotation to the chart at that point. The annotation text will simply be the wavenumber for the 
peak center. 

Ability to Save an Experiment as a Template 

Previously, a template had to be an existing, completed experiment file, data and all. Now, any 
experiment, live or completed, can be saved as a template that contains no data. The file extension 
of this template remains “.iCIR”. The purpose of this enhancement is not only to allow the use of a 
live experiment as a template, but also to make the process of loading the template faster when 
done remotely. This was necessary for support of iC IR for Process and the ReactIR 247 
instrument. 

Onboard Diagnostic Logs Available (ReactIR 15 only) 

For improved customer support, the ReactIR 15 instrument contains internal data storage that 
stores diagnostic data from the instrument. As long as the instrument is on, the diagnostic data will 
be logged, even if iC IR is idle or closed. The “Send System Logs” option on the Start Page or the 
Help menu will also create a comma-separated value (csv) file containing this diagnostics data for 
the requested date range. 

 

 

Enhancements for Version 4.1 

Data Treatments Now Applied to Reference Spectra in Experiments 

Any reference spectra added to an experiment, as well as those created by ConcIRT, will have the 
same data treatments applied as the spectra that were collected from the instrument.  This 
maintains data integrity by keeping all treatments the same for all spectra used in an analysis and 
also allows for easier comparison when math functions, like 2nd derivative, are applied.   

Note that spectra copied from an experiment into a spectra library will always maintain any data 
treatments.  

Annotate Points or Peaks in the Spectra Viewer 
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Users can label peaks or points in a pinned or reference spectrum in the Spectra Viewer pane.  The 
annotation defaults to the wave number, but the user can select an applicable functional group (if 
available) instead or enter their own text for the label. 

Pin Multiple Spectra at One Time 

The user can now select multiple samples in the Event log and pin/unpin the selected samples all 
at once. 

View Spectra in % Transmittance in Spectra Libraries 

Spectra libraries support a new option that allows spectra to be viewed in % Transmittance instead 
of absorbance.  This can be useful for comparing to standard reference spectra which are often 
recorded in % Transmittance. 

Rapid Collect Enhancements 

Rapid Collect mode now supports measuring RTD temperature data at sampling rates of 
approximately one sample per second.  With RTD trending disabled, even faster sampling rates 
can be obtained (depending on your acquisition settings). 

ConcIRT Pro Module Support 

With a ConcIRT Pro license installed, users can analyze reaction data using the ConcIRT algorithm 
post process. The ConcIRT Pro module is designed to analyze reaction data from one experiment 
or multiple experiments from one spectroscopy, or two experiments with two spectroscopies 
combined (such as IR and Raman, or IR and UV-VIS). Users can also manually select the number 
of components to calculate as well as provide reference spectra or trends as additional inputs for 
ConcIRT Pro analysis. 

Instrument Performance Assurance (IPA) Module Support 

Instrument Performance Assurance is a validation and calibration package available as an option 
for the ReactIR 45m and iC10 instruments. During instrument validation, a NIST traceable 
polystyrene sample is inserted into the optical path and the resultant peaks are compared with the 
NIST expected values. During instrument calibration, a polystyrene sample is inserted into the 
optical path and the resultant peaks are used to fine tune the laser frequency to its optimum value. 
This feature requires a ReactIR 45m or iC10 instrument, the Instrument Performance Assurance 
hardware module, and an additional software license available from METTLER TOLEDO. 

iC Quant Module Improvements 

iC Quant 4.1 has the ability to export QuantIR 2.0 (.QNT) files so that MonARC users can use iC 
Quant to build a PLS model, then export it and transfer it to the instrument for real time prediction. 
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The goodness-of-fit R2 values for the training data, test data and cross-validation are now 
displayed on the Actual vs Predicted charts to provide additional diagnostics information. 

Reminder about Filling MCT Dewar 

A reminder has been added to tell the user if they need to fill the dewar based on temperature 
sensor readings at the beginning of the experiment.  If there is not a temperature sensor on the 
system, then the user will always get a reminder for MCT type detectors. 

Individual Probe Gain 

The user can now change the gain for each probe rather than for the whole device. This allows 
probes of different types to be used on a single Fiber Multiplexer.  

Reporting to XPS 

In addition to sending reports to Microsoft Word, version 4.1 also allows reports to be sent directly 
to an XPS document.  XPS (XML Paper Specification) was developed by Microsoft to provide a 
read-only definition for document layout and formatting (similar to what an Adobe PDF provides).    
Users can now generate non-editable reports using XPS, and they can also create and view reports 
even if they do not have Microsoft Word installed on the PC.  

The XPS reader software included with Microsoft DotNet 3.0 (this is a free add-on that is installed 
with many software packages, such as iC IR, and is part of the standard Vista operating system). 

 

Enhanced Surface Viewer Printability 

The surface viewer is now saved as an image and copied with a higher DPI to enhance printability.  
The axis labels are also rendered with better clarity.  This enhanced image is available when 
reporting to XPS or MS Word as well as from the copy option in the Surface Viewer pane. 

 

 
Enhancements for Version 4.0 

New iC RCT Task Pane in Toolbox  

When installed, a new iC RCT (Remote Configuration Tool) task pane for MonARC 4.0 release 
appears in the Toolbox. See the MonARC 4.0 User Guide for installation instructions. 

Support for Windows Vista 32-bit Operating System 

iC IR4.0 is compatible with the Windows Vista Operating System as well as Windows XP. 
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NOTE: Although iC IR supports Vista, the ReactIR4000 instrument interface does not – so 
ReactIR4000 users must remain on Windows XP. 

Support for MultiProbe and MultiVessel Instruments 

Support has been added for MultiMaxIR™ (MMIR) and the Fiber MultiplexIR™ instruments. The 
Fiber MultiplexIR™ is a dual fiber probe instrument based on the ReactIR 45m interferometer. The 
MMIR R4000 is supported in two- and four-vessel configurations. A new MMIR variant based on 
the ReactIR 45m interferometer is also supported in two- and four-vessel configurations. Standard 
pressure and ambient vessels are supported on both MMIR platforms. 

Each probe or reactor has its own experiment document so each can be started and stopped 
independently and have different data acquisition settings and sample intervals. iC IR uses a 
scheduling algorithm to efficiently “share” the interferometer between the different experiments. 

One-Click Reporting 

One-click reporting is available now for all iC IR document types—Experiments, Result Sets, 
Sample Libraries, Univariate and Multivariate models. The report is a Microsoft Word document that 
can be edited, saved, and printed by the user. 

Auto Align 

An auto alignment feature has been added to the Contrast mode for the ReactIR 45m hardware. 
Click one button and, in a couple of minutes, the optimum optical alignment for the instrument is 
automatically determined. This feature is only applicable to the ReactIR 45m. 

User-Defined Trends in Result Sets 

Previously, user defined trends were only available for Experiments. This feature has been extended 
to also permit trend math in Result Sets. 

Data Table 

There is a new data table view that shows the numerical values in each trend for all pinned 
spectra. 

Rapid Collect Experiment 

Rapidly changing reactions can now be monitored using the new Rapid Collect mode for creating 
experiments. Sampling rates as fast as approximately one scan per second can be achieved. After 
the rapid reaction completes, a new Data Treatments option allows the user to select  the number 
of scans to co-add for each sample spectrum. This allows the user to select the optimal trade-off 
between sampling noise and number of samples. 



 

  27 

iC
 IR

 R
el

ea
se

 N
ot

es
   

Manually Sampled Experiment 

For at-line applications and analytical labs, the user can elect to create an experiment that is not 
based on a predefined acquisition schedule and instead “manually” collect a sample on demand. 
All Data Treatments and other experiment features behave the same as with a scheduled 
experiment. 

Append To Experiment 

It is now possible to append additional samples to an existing experiment file. This is particularly 
useful in conjunction with the Manually Sampled Experiment feature. For example, in an at-line 
application that involves taking a sample once a day, it is possible to track all the daily samples in 
a single file. 

Quick Sample and Background in Sample Library 

It is now possible to collect a background and a sample from a Sample Library document by 
clicking one button and bypassing any wizards. The user has the option of selecting the desired 
number of scans or requesting that the system select the number of scans automatically for the 
acquisition. 

Quantitative Methods in Sample Library 

Previously, quantitative methods could be used to create trends in an experiment, but it was not 
possible to execute a quant prediction against single samples. The Sample Library document has 
been extended to support Univariate and Multivariate quantitative methods for this purpose. 

Temperature Monitoring Calibration 

Temperature monitoring was introduced in 3.0 on the ReactIR 45m. In 4.0 we’ve added the ability 
to calibrate the RTDs using a one point (offset correction) method and a two point (response 
correction) method. This will assure a wide variety of devices can be supported. 

Import Trends from any iC/iControl 4.0 Experiment File 

All iC and iControl 4.0 applications now use a common data file format to allow for even better 
data exchange.  All iC and iControl applications now have the ability to import trends from any 
iC/iControl data file. In addition, iC IR also has the ability to import trends from legacy WinRC™ 
files which is particularly useful for including temperatures and other process variables while 
analyzing old MultiMaxIR™ experiments. 

Drag-and-Drop Trends Between iC and iControl 4.0 
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For users working with multiple iC and/or iControl 4.0 applications, it is now possible to drag and 
drop trends between any such applications running on the same computer. In the case of trends 
from a live experiment, the trend will continue to update in the application it is dropped into. 

iC Quant New Features 

iC Quant package implements the audit trail logging and tamper detection for 21 CFR Part 11 
electronic records.   

• The workflow for calibrating and validating a model is simplified and combined with model 
calibration.   

• Users can now flag a sample as an outlier in the Model Data table and the sample is 
excluded from model development.   

• It is now possible to display all PLS loading factors in the spectra viewer.   

• For easy reference, Outlier Limits now displays the 95% confidence limit for Mahalanabis 
distance and F-Test Statistic. 

 

Enhancements for Version 3.0 

Added AgX 1.5 meter Probes 

The software will now allow the user to configure the system for use with AgX 1.5 meter fiber 
probes. 

New Quick Start Guide 

This release includes the new, updated Quick Start Guide. 

Experiment Phases 

iC IR supports varying sample times throughout the course of the experiment. With this feature, 
samples can be collected more frequently during the “fast” parts of the reactions, and more slowly 
during the “slow” parts of the reaction. The Start Experiment wizard includes a new “Experiment 
Duration” page to create the phases. 

Experiment Templates 

The user can now apply experiment templates when creating a new experiment. An experiment 
template is any previously created experiment file. When applying an experiment template to a new 
experiment, the template’s Peak Definitions, Data Treatments, Reference Spectra, and Phase 
definitions are copied to the new experiment before it starts.  
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Enhanced Live Experiment Tool Bar 

iC IR includes an all new Live Experiment Toolbar when running experiments. This toolbar 
maintains the Pause/Resume and Quick annotation features of the previous edition, while adding 
advanced functionality. The Toolbar has timers to track the experiment Elapsed Time, time until the 
Next Measurement, and the Time Remaining in the experiment. Also, the sample interval and 
phases can be edited from the Toolbar without pausing the experiment. 

User-Defined Trends 

The User Defined Trends Task Pane gives the user the ability to perform certain math operations on 
existing trends in their experiments. In addition to the basic math operations, the User Defined 
Trends Task Pane has functions to calculate % Yield and % Conversion. 

Fit Chromatography Data 

With the Live Experiment Toolbar and User Defined Trends, users can scale a relative trend (ex. 
ConcIRT, peak profile, etc.) to quantitative data from HPLC or other referee data sources. The 
function calculates the linear equation correlating the relative trend to the chromatography data 
(based on a least squares fit). This linear equation is then applied to each point in the relative trend 
to scale to the quantitative data. 

iC Quant 

Back by popular demand, after a four year hiatus from the pc and screen, METTLER TOLEDO and 
iC IR are proud to reintroduce a quantitative analysis package; iC Quant™.  iC Quant has all the 
features you love from QuantIR, with all the goodness of the iC Framework and linked view user 
interface.  Models created in legacy QuantIR can be imported into the new iC Quant, and used for 
prediction in experiments. 

 

Integration with iControl 

iC IR experiments can be coordinated with experiments in iControl 3.3.  iControl can choose 
templates, start experiments, and copy trend data from iC IR.  

Background Replacement 

The Data Treatments Task Pane features a new advanced function to replace the background for all 
spectra in an experiment.  This is useful to investigate the results of a given data set by using 
different backgrounds (i.e. solvent backgrounds).  

Import legacy ReactIR data files (spa, mts, etc.) 
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iC IR now allows users to import legacy data files into experiments and spectra library documents.  
The imported data can be used for iC Quant analysis and all iC IR Data Treatments and functions. 

Extract Background and Singlebeam 

iC IR now allows the user to extract the background or singlebeam from a spectrum collected with 
the software.  This is an advanced feature for those quite familiar with IR spectroscopy and those 
who tend to process their data through more elaborate means. 

 

 
Enhancements for Version 2.0 

R4000 Support 

iC IR 2.0 can communicate with and collect spectra from a ReactIR4000 instrument. This requires 
only a software upgrade to the R4000 itself. No hardware change is required (if upgrading from 
ReactIR 3.0). See the iC IR 2.0 Installation Procedure for details on upgrading an R4000. 

Open ReactIR Experiments 

The Open Experiment dialog (accessed from the File menu or Start Page) now also support ReactIR 
3.x and 2.x file types. This means you can analyze reaction data collected with ReactIR 3.x or 2.x 
in iC IR 2.0. 

Spectra Library Documents with Drag-and-Drop 

Spectra Libraries are now documents that can be opened as tabbed windows just like experiments 
and result sets. This allows a user to open multiple spectra library documents simultaneously, drag 
and drop spectra between documents and to open or create a new spectra library without requiring 
a device to be connected. 

Solvent Subtraction in Spectra Libraries 

Solvent subtraction is now available in Spectra Libraries as well as experiments. 

Graceful Handling of Spectra from Different Instruments 

Spectra from different experiments which were collected using different instrument configurations 
can now be viewed within the same spectra library. In addition, adjustments are automatically 
made to account for small differences in laser frequency between different iC10 instruments so you 
can import reference spectra into an experiment even if they were collected on a different 
instrument. 
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Easier Than Ever to Add Annotations 

During live experiments, a Quick Annotation toolbar is available. The annotation will be associated 
with the time you press the Enter key. You can add annotations at other times from right-click 
context menus in the Event Viewer and Trend Viewer controls or by pressing the F5 function key. 

Drag Annotation Markers 

The position of Annotation markers in the Trend Viewer control can be moved by dragging the 
marker. Just right-click on the marker and select Move Annotation from the context menu to enable 
dragging. 

Show/Hide Experiment Viewer Controls 

Toolbar buttons now provide you the means to show/hide each of the four primary experiment 
viewer controls (TrendViewer, SpectraViewer, EventViewer, SurfaceViewer). 

View the Background or Singlebeam 

You can view the background or singlebeam associated with a spectrum in an experiment by right-
clicking the spectrum in the Spectra Viewer and selecting Extract ->Background, Singlebeam. 

Clickable Legends 

Clicking on an item in the legend of the TrendViewer or SpectraViewer selects the corresponding 
trend/spectrum. 

Grid Panel Including Y-Axis Assignments 

The grid panel of the TrendViewer and SpectraViewer provides additional information about the 
selected trend/spectrum. You can also rename, change color or assign a different Y-Axis to a data 
series from this panel. 

Automatically Export Spectra/Trend Data during Experiment 

While running an experiment, the User can elect to have the system export a Grams SPC formatted 
file, or a CSV file for every new acquisition. In addition, the User can elect to have each new trend 
data point exported to a file. The target directory and base file name are User configurable. This 
option is available under the Tools menu. 

Drag-and-Drop Reference Trends 

You can now drag and drop reference trends into experiments from other experiments or result sets. 

Trend Temperature Data during Performance and Stability Test 
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While executing the Performance or Stability test, the User can elect to have the system acquire and 
trend temperature data from the hardware. This feature is only available when using a ReactIR iC10 
instrument. 

Manual Alignment of Fixed Mirror 

While running the Contrast mode test, the User can manually adjust the fixed mirror position using 
left, right, up, and down buttons. This feature is only available when using a ReactIR  iC10 
Instrument.High Contrast Charts 

The TrendViewer and SpectraViewer controls now support a context menu option for “High Contrast 
Mode” which switches to a black background instead of white and draws thinner lines on the chart. 

Smart Copy As Text in TrendViewer 

The format of data generated by the Copy As Text feature of TrendViewer has been improved to 
allow for easier data analysis using programs such as Microsoft Excel. 

 

Enhancements for Version 1.5 

New data treatments 

The Experiment Task Pane has been renamed Data Treatments and it contains many new and 
exciting features: 

• Baseline Offset 

• Normalize 

• Smoothing 

• Math functions (1st, 2nd, 3rd derivative + sqrt) 

• ConcIRT region selection 

• Show/hide ConcIRT component spectra 

Simplified spectra pinning 

The SpectraViewer toolbar now includes an icon that allows you to pin/unpin the current selected 
spectra. This eliminates the need to open the Spectra / Peak List to pin/unpin spectra. 

Auto-assigned colors on SpectraViewer 

Pinned spectra are now auto-assigned unique colors which can still change, if you want. 

SurfaceViewer copy 
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You can now copy and paste the SurfaceViewer image into Word or other programs that accept 
bitmap images. 

EventViewer copy 

You can now copy and paste the data from the EventViewer list into Excel or other programs that 
accept tab-delimited text. 

Ability to remove bad samples 

If your experiment includes a bad sample that is preventing ConcIRT from analyzing your data, 
simply select the bad spectrum and press Ctrl-Shift-Delete. After confirming your intentions, the 
system will remove the bad data from the experiment and reprocess the reaction. 

Backup file created when saving experiment 

As a precaution to avoid the possibility of lost data, whenever you save an experiment, the 
previous data is retained in a backup file. The backup file is automatically removed when you close 
the experiment form. 

Unique default name for each experiment 

When you start a new experiment, the system now offers a unique default experiment name 
including the current date and time. 

Visual indication of ConcIRT status 

Messages are now displayed in the status bar whenever ConcIRT starts processing and also when 
it completes processing or fails. 

 

 

Export Spectrum 

Right-click on a spectrum in the SpectraViewer and you now have the option to export it as a .mts 
file for use with ReactIR 3.0. 

Create Reference Spectrum 

You can now create reference spectra from reaction spectra. This is a great time-saver. For 
example, instead of collecting a solvent reference spectrum before you start your experiment, you 
can just right-click on the first reaction spectrum (which contains pure solvent) and select the 
option to Create Reference. The solvent is now immediately available in for spectrum subtraction. 
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Linked Crosshairs 

You can click directly in the SurfaceViewer to select any point on the surface. Crosshairs 
immediately jump to the selected point and a tooltip displays info about that point. The TrendViewer 
and EventViewer highlight the corresponding time.  And, coolest of all, if you turn on the new 
crosshairs option in the SpectraViewer, they will jump to the highlighted point.  Conversely, moving 
the crosshairs in the SpectraViewer changes the crosshair position in the SurfaceViewer. You can 
also use the arrow keys in the SurfaceViewer to “nudge” the crosshairs exactly where you want 
them. 

Enhanced Add Peak 

Clicking the Add peak button in the SpectraViewer while the crosshairs are on will create a height to 
zero peak exactly at the crosshairs. Used in conjunction with Linked Crosshairs, it’s easier than 
ever to create peaks. 

Functional Groups 

The use of functional groups within iC IR has been significantly enhanced. Most notably, tooltips in 
the SpectraViewer will now display relevant functional groups as you hover the cursor. The tooltip 
updates dynamically as you drag the mouse including adjustments to peaks (see below for more 
on this). Functional groups are also used in the new Rename feature for selected peaks in the 
SpectraViewer. 

Absolute/Relative Time Mode 

The TrendViewer now supports a context menu option to toggle between displaying relative or 
absolute time. This feature can be used in experiments and result sets. 

Reset Zoom Toolbar Button 

The toolbars in SpectraViewer and TrendViewer now have a Reset Zoom button as well as Zoom.  
This provides greater ease of user and consistency with the context menus. 

Graphical Peak Editing 

You can easily edit peaks graphically from the SpectraViewer chart rather than having to go to the 
Peak Edit Panel. You can delete peaks, change peak type or rename peaks directly from context 
menus. The rename is particularly cool because the system automatically suggests applicable 
functional group names based on the peak position. 

Quantitative Analysis 

This version includes an optional add-in module that allows iC IR to interoperate with Grams. You 
can enable this add-in by copying all the files from the IQPredict folder into the main iC IR program 
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folder and restarting iC IR. This will add a Quantitative Analysis task pane which allows you to 
export reaction spectra in SPC format for import into Grams. It also lets you import a calibration file 
(.cal file) created within Grams. Once the cal file is loaded, iC IR runs the calibration on the 
reaction spectra and displays concentration profiles in the TrendViewer. 

SPC Export Enhancements 

The SPC Export function has been enhanced to allow spectra to be exported as individual files.  
This helps with import into certain analytical packages that don’t work well with SPC multifiles. 

ConcIRT Time Region Selection 

It is now possible to have ConcIRT only process part of reaction. Optional selection of time region 
complements the option of select the spectral region for ConcIRT to allow the best possible analysis 
of each dataset. 

More User Preferences 

The Options dialog now offers more options to tailor the default behavior of iC IR. Options are also 
now grouped by area to be more intuitive. Users upgrading to this version of iC IR are encouraged 
to click the Restore Defaults button on the Options dialog to load the latest user preference profile. 

 

 

Enhancements for Version 1.1 

Fixed system lockups 

Errors in the way multiple threads synchronized access to shard data have been corrected. This 
eliminates problems that previously resulted in the system occassionally "locking up" or "hanging".   

 

Fixed 3D graphics errors 

Errors in the way the SurfaceViewer control interacts with underlying DirectX 3D graphics libraries 
have been corrected. This eliminates problems that previously resulted in the SurfaceViewer 
sometimes failing to initialize or going blank after a period of time.   

Improved 3D graphics performance 

The use of DirectX has been optimized resulting in a notable performance improvement in the 
SurfaceViewer control.   
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Improved UI for Experiment Task Pane 

The user interface to the Experiment task pane has been improved. The new layout provides a more 
logical and intuitive grouping of controls.   

Load reference spectra during experiment 

Previously, it was not possible to load reference spectra while recording an experiment. The new 
Experiment task pane now allows reference spectra to be loaded at any time.   

Remember changes to instrument configuration 

Changes to instrument configuration are now properly saved and restored between sessions.   

TrendViewer Y-axis scaling 

A flaw in the auto-scaling of TrendViewer profiles has been corrected.   

SpectraViewer X-axis no longer bounces 

Previously, if you zoomed in on the extreme right edge of the SpectraViewer during an experiment, 
the X axis would shift slightly when the next spectrum was acquired. This has been fixed.   

Consistent visible width of single wavenumber peaks 

When single wavenumber peaks are shown on the SpectraViewer, they are displayed a bit wider to 
make it easier to click and drag the peak. This adjustment now correctly scales the peak width 
considering the current size of the control and zoom factor such that the visible peak width remains 
constant regardless of how you pan or zoom around the spectra data.   

Instrument contention prevented 

The system now avoids a multitude of problems by ensuring that user does not initiate two 
instrument actions at the same time.    

Graceful handling of hardware not detected during startup 

If the system is configured to communicate with an FTIR instrument, but the instrument is not 
detected during startup, the user is alerted and given the option to continue or retry. Retry is useful 
if the instrument was not connected or turned on. If the user cancels, the system will automatically 
add a simulated FTIR device, if one is not already configured.   

Simulated experiments start with first spectrum 

Whenever a simulated experiment is started, the system starts reading simulated data from the first 
spectrum, even if you collected simulated reference spectra during the start experiment wizard.   
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Config file initialization 

The configuration file has been renamed from config.xml to iCIR.xml. A default config file is 
deployed with the iCIR program and is now automatically copied to the user directory the first time 
the application is run.   

Additional Troubleshooting procedures 

The help file has been updated with two new troubleshooting procedures. One describes what to do 
if you see the FTIR Instrument Failure dialog. The other describes what to do to avoid the Select 
Instrument dialog.  Pressing F1 on either of these dialogs will display the proper help page.   

Improved logging 

This release includes significantly improved logging that will greatly help with troubleshooting any 
system issues encountered in the future.   

The LogManager utility program has been improved to make it easier to save or send log files. Use 
the "Send Logs" button if your computer is connected to the internet and is configured to allow you 
to send email. Otherwise, use the "Save Logs" button and copy the files to another computer where 
you can email them to us. 

 

 

Enhancements for Version 1.0 

Context-sensitive help 

The largest single enhancement to build 1.0.3500.45 is the integration of extensive, context-
sensitive help. Pressing F1 at any time while running iC IR will display the help file page that is 
most relevant to the current active window. 

One-click problem reporting 

A new utility program is now included with iC IR that will allow the user to view system log files, 
export files to disk and even submit bug reports. This program is part of our commitment to ensure 
that all system issues are addressed promptly and effectively. 

AutoScale option for TrendViewer/SpectraViewer 

Y-axis scaling on the TrendViewer and SpectraViewer controls has been dramatically improved.  
There is now an AutoScale toggle button on the toolbar for each of these controls. When enabled, 
the graph automatically autoscales all Y axes to the range of the values in the displayed X range.  
The system automatically adjusts Y scaling as you pan back and forth in X. 
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Display time of last background 

The Collect Background pages of the Configure Instrument, Record Spectra, and Start Experiment 
wizards now display the time and date of the last background to have been recorded. This is useful 
information to the user deciding whether to use the current background or to collect a new one. 

Proper handling of Pause 

A defect has been corrected that was resulting in the same spectra being stored twice if the system 
was paused while scanning. This is important because the duplicate data was confusing ConcIRT. 

Proper handling of non-US numeric formats 

When running with the FTIR Simulator device, simulated data for the Align and Clean pages of the 
wizards is read from twotext files deployed with the software: PERCENTLINE.DAT and 
SINGLEBEAM.DAT. These are text files that contain numbers formatted using the US English 
convention of period as decimal point. The software would raise an exception reading these files 
when run on a computer with a foreign version of Windows that used different number formatting 
rules (for example, many European countries use comma as the decimal point). The software now 
corrects this error by always reading using the US "culture" object, rather than using the default 
culture defined on the machine. 

Experiment files grow too large 

Whenever an experiment file is closed, the system now compacts the file to minimize disk usage.  
This is a significant improvement because long experiments were previously growing quite large. A 
24 experiment could grow to nearly a gigabyte. Such files are now compressed by a factor of 20x 
or more. 

Incorporate updated Midget device driver 

This build includes an updated device driver for communicating with the iC10 that improves 
system reliability. 

Don't allow application exit while experiment is active 

Previously, the iC IR application would exit immediately when the user selected the Exit option from 
the file menu or clicked the application close button. Now, exit requests are denied with a polite 
user message while an active experiment or test is in progress. 

Confirm user request to close a file that has been changed 

The system now tracks when a document has been changed. If the user attempts to close a "dirty" 
file, the system now offers to save their work first. 
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Toolbar should be displayed by default 

The toolbars for the TrendViewer and SpectraViewer are now displayed by default to improve the 
discoverability of the user interface. Previously, they were hidden and could only be made visible 
by selecting an option from a context (right-click) menu. For those who prefer the cleaner look 
without the toolbars, a user preference option has been added to hide the toolbars by default. 

Exception entering non-numeric peak parameters 

Entering non-numeric values in the Peak Editor window was resulting in exceptions. These input 
errors are now handled gracefully. 

Allow duplicate trend names in result set 

Previously, a result set graph would not allow two points that used the same name to be displayed 
on the same graph. This sometimes made it difficult to compare similar data from multiple 
experiments. This restriction has been lifted. 

Update Start Page 

The Start Page has been revamped with a cleaner look that better communicates the logical 
structure of the iC IR software. In addition, new buttons have been added to allow: 

• Configure Instrument (previously this was only accessible from the Instrument 
Configuration task pane). 

• View System Logs (this button activates a slick new utility program that also lets you 
export logs or submit bug reports over the web). 

• Display User Documentation. 
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